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CHAPTER 21 - WEB STUDIO MENUS 
 

File 

 

• New Project: This will create a new one-page, blank web site for you to begin constructing. 

• Open Project: This will enable you to open a previously saved Project from your hard drive.   

• Close Project: Closes the currently active web site. This will prompt you to save your 
current Project if it hasn’t been saved.  If it is the first time you are saving the file, you will 
be asked to name your file.  Click Cancel if you don't want to save the site. 

• Save Project: Saves the current Project.  The Save As Dialog Box will launch if this is the 
first time you are saving the file.  If it is a "resave," you will not be prompted to name the 
file. 

• Save Project As: Saves the current Project and prompts you for a file name. This is 
normally used the first time you save a Project. But it can also be used to save a Project with 
a different name. This is a good way to save a backup of your important Project to folder on 
your hard drive!  Give the file an alternative name to make a back up.  For Example: 
MyProject would become MyProject1.  

• Print Setup: This command brings up your printer software and enables you to make basic 
printer adjustments such as paper-size, orientation, and paper source. 

• Print Page: This command enables you to print your current Web page.  The Print Preview 
dialog will come up to allow you to preview the page and make any adjustments to printing. 
The printing in Web Studio 4.0 is high quality printing, it uses the resolution you have set on 
your printer. Previous versions of Web Studio always printed at 72dpi, or screen resolution. 

• Quit: Closes the program.  If you have an open Project, you will be asked if you want to 
save it.  If you do, click "Yes", if you do not, click "No".  Web Studio will now shut down. 
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Edit 

 

 

• Undo: Undo your last action.  The menu text will specify what is being "undone".  This 
feature has no limit, so you can undo all of your actions right up to the point you opened the 
Web site.  In addition, each page you are working on maintains its own undo list.  So, 
switching between pages will not affect the undo list for each page. 

Note: As the Undo list grows, the amount of computer memory required grows.  For this 
reason it is a good idea to save your site as you go.  Each time you save your site memory is 
freed up, and the Undo list is erased.  So, use it when you are happy with your site and your 
system should perform a bit faster as a result. 

• Redo: This will undo your undo.  The menu text will notify you what is being "redone". 

• Clear Undo Lists: This command enables you to free up memory and resources that are 
part of the undo lists for each open page. Use this when you see a low on memory or 
resources error dialog. Once you choose this, you won’t be able to undo anything you’ve 
done previously. It clears the undo lists for all open pages, closed pages’ undo lists are 
already cleared when closing the page. 

• Cut: Cut will place the object or text you have chosen to the Clipboard and remove it from 
the page you are working on.  This is not limited to one object.  By holding down the Shift 
key and selecting several items, you can cut and paste several items at once. 
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• Copy: Copy will place a duplicate of the object or text that you are working on to the 
Windows Clipboard, allowing you to paste it into another Web page or another program. 

• Copy Background: Copy Background will place a copy of the page’s background graphic on 
the clipboard. It will not place a copy of a page’s background if it is a simple solid color 
background. The purpose of Copy Background is to enable copying backgrounds from one 
page and using Paste As Background to paste it into other pages. 

• Paste: Paste will place the object you have placed on the Windows clipboard on the active 
page on your screen.  You can paste multiple copies of your object or text simply by right-
clicking and choosing paste multiple times. 

• Paste in Place: This will Paste an object in the same location on the page that it was Cut or 
Copied from. This is handy when you want to place objects in the same location on different 
pages. Place them where you want on one page, copy them, go to other pages and choose 
Paste In Place. 

• Paste as Background: Enables you to paste the selected image, or text, as your 
background. 

• Clear: Clear will delete the object or text from the page.   

• Select All: Select All selects every object on your Web page. This enables for a group move 
or a group cut or copy. When you are editing text, select all will select all of the text in the 
object you are editing. 

• Edit HTML Source (Advanced feature): This enables you to edit the source in the selected 
text object. You may want to do this to add some advanced HTML features to your text 
object or to adjust text that was inserted from another program. 

• Search and Replace: This enables you to search for any text in a text object and optionally 
replace it with other text. 

• Program Preferences: This will open the global Preferences dialog. The setting in this 
dialog affect all of your websites and allow you to customize the way Web Studio works. 
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View  

 

• Galleries: You can turn the Galleries on and off (displayed and not displayed) by adding or 
removing the check next to "Galleries".  This comes in handy if you wish to view the entire 
Web page that you are working on.  Click the View menu and choose Galleries. For complete 
documentation of the Galleries, refer to Chapter 5, Working With the Galleries. 

Note: a little known shortcut using the keyboard is to type ALT-B. That will turn the Galleries 
on or off.  Why “B”? The galleries were first named “Browsers” when Web Studio was initially 
designed. “B” was for “Browser”. The galleries were subsequently named Galleries to 
eliminate any confusion with web browsers. 

• Page List: You can turn the Page List on and off (displayed and not displayed) by adding or 
removing the check next to "Page List".  The Page List is on the right side of the screen and 
enables you to see and select the Web pages on your site via a simple click on the desired 
page.  For complete documentation of the PageList and what it does, refer to Chapter 23, 
The Toolbars. 

Note: a little known shortcut using the keyboard is to type ALT-P. That will turn the Page 
List on or off. 

• Main Toolbar: The check mark indicates the status of the Toolbar.  It contains buttons that 
enable basic editing and Web page building functions.  For complete documentation of the 
Main Toolbar, refer to Chapter 23, The Toolbars. 

• Format Toolbar: You can turn the Format Toolbar on and off (displayed and not displayed) 
by adding or removing the check next to "Format toolbar".  The Format Toolbar is used to 
Format any text you add to your Web pages. 

• Layout Toolbar: This toolbar contains the Web Studio layout tools. These include 
alignment, spacing, centering, resizing, and the grid control. For complete documentation of 
the Layout Toolbar, refer to Chapter 23, The Toolbars. 

• Status Bar: The Status Bar enables you to move your mouse cursor over items in the 
Galleries and on the page and have information about that item to be displayed in the status 
bar at the bottom of the window.  Again, you can turn the Status Bar on and off (displayed 
and not displayed) by adding or removing the check next to "Status Bar".   
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• Small Thumbnails: You can choose to view large thumbnails or small thumbnails in the 
Galleries by choosing this command.  A check mark indicates small thumbnails and no check 
mark will indicate large thumbnails.  Small thumbnails is the default setting. 

• Highlight Objects: While you design your pages, Web Studio can notify you of the status of 
an object by having the object display a colored box when it is affected by your design.  Each 
of these options are turned off or turned on by clicking on them with the mouse.  A check 
mark will notify "turned on". 

 

• No Highlighting: Checking this option shuts off all of the other options. 

• With Links: This will either hide or display the link boxes that surround any icon, sign, 
button, photo, or text that has had a link added to it.  When the check mark is visible, 
there will be a colored box around the graphic.  (To change the color of the link box, see 
the chapter on Link Properties.) 

• That Overlap: Any objects that overlap on your pages will automatically be merged into 
a single graphic when you preview or post the Web site when using HTML 3.2.  This is 
done to retain your desired layout.  However, for those who would rather not have this 
"conversion" take place, this can help alert you to overlaps of objects. 

• Text Objects Converted to Graphics on your Web page: When using uncommon 
fonts (those listed in yellow or red in the Text gallery) Web Studio will convert the text to 
a graphic to retain the design integrity of your pages.  Choose this item to identify those 
objects that will be converted. If you would rather the text not be you’ll have to use only 
Black or Blue fonts. 

You can control whether text objects will be converted to graphics using the Web Site 
Properties dialog. Choose WebSite>Web Site Properties and click on the Advanced tab. 
At the bottom are two check boxes that control this feature. Web Studio is shipped with 
the “Red” check box turned on.   

Note 1: You may want to turn this feature off if you are using your website in an 
environment where you know all viewers of your site will have the fonts you’ve used in 
the site.  

Note 2: You may want to turn this feature off if you are using Web Studio as a drawing 
program and wish the text to print at high resolution. If these check boxes are checked, 
the text will print at screen resolution. 
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Control from the Web Site Properties dialog’s Advanced tab for converting Text objects to graphics 

 

Note 3: It may seem “bad” that if you use a special font, Web Studio converts the text 
to a graphic. Well, the professional web site designers have to do the same thing. The 
pros, however, use Photoshop (a really expensive program that edits graphics) to turn 
their text into graphics when they want to use a fancy font. Then they have to save it, 
import it, and place it on their web page. All you have to do is check this option and Web 
Studio (a relatively inexpensive web authoring program that also happens to edits 
graphics) will handle it without you even having to know the problem exists.  

 

Insert 

 

• Text from File: Opens the Windows Open dialog and enables you to import a text file to 
your page. The text is placed in a new text object on the page in the upper left corner. Web 
Studio can import many different types of text files. 

• New Text Object: This places a new, empty text object on your page in the upper left 
corner. It sets the default font to Times Roman, 10 point. To insert a new text object with a 
different font, use the Text Gallery and drag the font you like onto the page.  
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Note: A little know keyboard shortcut exists for adding text objects to a page. Hold down 
the ALT key and click on the page where you want the text object to appear, then drag to 
the size you want. 

• Picture from File: Using the Windows Open dialog, enables you to import a graphic file to 
your page. Also used to insert Photos from Digital Cameras that act like disk drives. Web 
Studio can import many different types of graphic files. 

• Picture from Scan: Utilizing you scanner software, it enables you to scan a photo into the 
program for use on your Web page.  Compatible with any TWAIN device such as Digital 
Cameras, scanners, etc. 

• Flash Animation from a File: Using the Windows Open dialog, enables you to add a Flash 
Animation to a page.  If an HTML file exists with the Flash file it will be used to set the size 
and other settings for the Flash object. If no HTML file exists for the Flash file, Web Studio 
will read the size from the Flash file itself.  

• Protected Graphic From File: Using the Windows Open dialog, enables you to import a 
graphic file for use on your web page. The difference between this and Insert Picture From 
File is that Web Studio will make not changes to the graphic when it builds your website; it 
can be reused (copied and pasted) many times and it will use no additional space on your 
website. This type of graphic cannot be changed with any of Web Studio’s Special FX or 
other tools that would modify it. It can only be resized and moved on a page. 

Note: This type of graphic is useful for graphics that have been optimized for the web by 
another program. They are also useful for those people who are trying to minimize the size 
of their website. 

• HTML from a File: Using the Windows Open dialog, enables you to add an HTML file to a 
page. The HTML will be placed in a Web Studio HTML object. Note that any of 20+ formats 
can be inserted in addition to HTML. 

• Background from File: Using the Windows Open dialog, enables you to import a graphic 
file as your background. Also used to add backgrounds using Photos from Digital Cameras 
that act like disk drives. 

• Background from Scan: Utilizing your Scanner software, it enables you to scan a graphic 
into the program for use as your Web page background.  Compatible with any TWAIN device 
such as Digital Cameras, scanners, etc. 

• Sound File in Object or Page: Enables you to import a sound file into a selected object or 
as the page’s background sound using the Windows Open dialog. Note that a sound added to 
a selected object is actually a link in that object. 

• Video File On Page: Enables you to import a video or movie file using the Windows Open 
dialog.  

• My Links Gallery link: Enables you to add a URL hyperlink to you’re My Links folder in the 
Links Gallery.  Any valid URL can be used, including FTP, HTTP, and Mailto. 
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• Downloadable File Link: Enables you to add a downloadable file to your site. It is placed 
as a link into the Downloads list in the Links gallery. You then drag and drop the 
Downloadable link onto an object (button) to enable visitors to download the file. 

• My Stuff Tab graphics: Displays the Windows Open dialog, which enables you to add files 
from your Hard Disk or CD-Rom to the My Stuff Gallery.  Files are added one at a time, so if 
you wish to add more than one at a time do the following. 

To add several files in one folder, hold down the CTRL key and click on each file name you 
wish to add.  Click OK and all the files will be added to the My Stuff Gallery. 

To add an entire folder of files, hold down the Shift key and click on the first and last file in 
the folder.  They will all be highlighted and then click OK.  All the files will be loaded into the 
My Stuff Gallery. 

• Content From WebStudio.com: This opens a window in Web Studio and goes to the 
Content Gallery on the WebStudio.com web site. You can choose galleries of content there 
which will be automatically downloaded and installed into your Web Studio.  

The new content is added to the appropriate Gallery the next time you click the Gallery’s tab. 

So if you download, for example, Buttons, you would download it, then click on another 
Gallery’s tab then click on the Buttons tab. At that point the new content is installed, and a 
new icon is added to the start of the gallery. There is a yellow folder icon there indicating 
that you should double click on the new icon to see and use your new content.  

See Chapter 5 – Working With The Galleries for specific instructions on how to 
automatically add content from the WebStudio.com web site to your Web Studio 
4.0 Galleries.  
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Format  

 

• Font: Enables you to alter the font, style and/or size of the selected Text on the page.  
Displays the standard Windows Font dialog box. 

• Text Color: Changes the color of the selected text. 

• Text Background Color: Enables you to choose a color to be placed behind the text. 

• Transparent Text Background: Default option.  Text uses the Web page background. 

• Left Justify: Places the selected paragraphs to the left margin of the text box.  If no text is 
selected it will justify only the paragraph that has the cursor blinking in it.  If text is selected 
it will justify all paragraphs that are part of the selection.   

• Center Justify: Centers the selected paragraph in the text box. If no text is selected it will 
justify only the paragraph that has the cursor blinking in it.  If text is selected it will justify all 
paragraphs that are part of the selection.   

• Right Justify: Places the selected paragraph in the right margin of the text box.  If no text 
is selected it will justify only the paragraph that has the cursor blinking in it.  If text is 
selected it will justify all paragraphs that are part of the selection.   

• Full Justify: Spreads text across the line so each line extends from the left to right margins. 
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• Increase Paragraph Indent: This increases the amount of indentation for the selected 
paragraphs. 

• Decrease Paragraph Indent: This decreases the amount of indentation for the selected 
paragraphs.  

• Increase Heading Size: This increases the size of the paragraph’s HTML heading. There 
are six sizes of heading in HTML. Headings are important to use if you want your site ranked 
well by search engines. The search engines consider any text that is part of an HTML 
heading to be more important that other text on your page; the larger the heading, the more 
important. 

• Indent First Line: Indents the first line in your paragraph.  Text must be selected. 

• Paragraph Indent: Indents the entire paragraph.  Text must be selected. 

• Special Characters: This brings up the Windows CharMap program’s dialog. You can 
choose from among any of the fonts in your system, and choose a “special” character to 
enter into your text. Do this by double clicking on the character. The character will be 
displayed in the Characters to copy field at the bottom of the dialog. Note that you can 
double click multiple times to enter more than one character. When you are done, simply 
close the dialog with the close button and the characters will be entered into the active text 
object at the insertion point. 

• Check Spelling: Activates the Web Studio Spell Checker.  In order to check the spelling of 
any text object, the text object must be active for editing or be selected.  Otherwise this 
option will be grayed. 
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Object  

 

• Save Selected Object As: This command enables you to select any graphic or any text 
object and save them to disk. Graphics can be saved as Windows Bitmap files (BMP), GIF 
files, or JPG files; text objects can be saved as Text files (TXT) or HTML files (HTM).   

Saving graphics enables you to use Web Studio’s cool Special FX on any graphic you have 
and then save it. You can use Web Studio as a graphics editor for all your other programs 
and projects. 

• Transparency Menu 

 

• Transparent: Changes the transparency of an object.  When transparent, the object 
appears to be floating above the background.  The transparent color is actually made 
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transparent so things below the object can be seen. So, if you choose white as the 
transparent color, all white pixels in the graphic will be “see-through”, and the same with 
any other color you choose. 

• Transparent White: Default.  Any white in the object is transparent. 

• Choose Color: Enables you to change the transparent color. 

• Align Tops: Aligns the tops of two or more objects.  Similar to a Snap to command.  Select 
two or more objects by holding down Shift and select each object with the Mouse.  Aligns to 
the top most object. 

• Align Bottoms: Aligns bottoms of two or more objects.  Similar to a Snap to command.  
Select two or more objects by holding down Shift and select each object with the Mouse.  
Aligns to the bottom most object. 

• Align Left Sides: Aligns the left sides of two or more objects.  Similar to a Snap to 
command.  Select two or more objects by holding down Shift and select each object with the 
Mouse.  Aligns to the left most object. 

• Align Right Sides: Aligns the right sides of two or more objects.  Similar to a Snap to 
command.  Select two or more objects by holding down Shift and select each object with the 
Mouse.  Aligns to the right most object. 

• Center Selected Objects: Centers two or more objects relative to each other. It centers 
relative to the first object selected. 

• Center On Page: Centers one or more objects on the page horizontally. It uses the current 
page’s width to determine where to center.  

• Space Evenly Across: Spaces out the selected objects evenly from left to right. 

• Space Evenly Down: Spaces out the selected objects evenly up and down. 

• Make Equal… 

 

• Make Equal Size: Makes the selected objects the same size. Select two or more objects 
by holding down Shift and select each object with the Mouse.  Resizes relative to the size 
of the first object selected. 

• Make Equal Width: Makes the selected objects the same width. Select two or more 
objects by holding down Shift and select each object with the Mouse.  Resizes relative to 
the width of the first object selected. 

• Make Equal Height: Makes the selected objects the same height. Select two or more 
objects by holding down Shift and select each object with the Mouse.  Resizes relative to 
the height of the first object selected. 
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• Merge Selected Objects: Merges selected objects into one graphic.  Similar to merging 
layers in graphics programs.  

Note: You can merge graphic objects together as well as Text objects or any mixture of the 
two. 

• Take Object Apart: Takes multi-part graphic objects apart and places each graphic on the 
page in sequence. Multi-part graphics are Animations and Rollover buttons. This is useful for 
changing the order of an animation, adding to an animation or deleting graphics from an 
animation. It can be used with Rollover Buttons to change the order or change one or more 
of the graphics in an existing Rollover. 

• Turn into a Protected Graphic: This turns the selected graphic into a Protected Graphic. 
The Windows Save As dialog will come up to enable you to save the graphic to disk. 
Protected Graphics can be used many times on a site while being uploaded only once. In 
addition, a Protected Graphic is not changed in any way by Web Studio when it uploads the 
graphic. 

• Bring Selected Object to the Front: This moves the selected item to the top layer of your 
Web page.   

Note: All of the Bring Selected object to the … and Move Selected Object…commands can be 
used with selections of objects. For example, choosing Bring Selected Object to the Front will 
bring the selection in front of all the other objects. 

• Send Selected Object to the Back: This moves the selected item to the bottom layer of 
your Web page.   

• Move Selected Object Forward: Moves the selected object one layer forward. 

• Move Selected Object Backward: Moves the selected object one layer backward. 

• Links Menu: 

 

• Remove Link: Removes the Hyperlink from the selected object. 

• Add/Edit Link: Brings up the Add/Edit Link dialog. You can then view the Hyperlink 
information or change it as needed or add a new link to the object. 

• Object Properties: Displays the object properties box. 
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Page  

 

• New Page: This command will add a new, blank, untitled page to your site. The page’s 
name is added to the end of the PageList. The new page is immediately opened for you. 

• Duplicate Page: This command will immediately create a duplicate of the current page 
and add it to your web site. This is very handy if you want to have an overall visual 
theme for your site. You create one page that has all of the common elements on it, and 
then duplicate it as many times as you need. 

• Delete Page: This command will delete the current. 

• Open Page: This command enables you to open a previously saved Web Studio page. 
The page is added to the Project and is added to the end of the PageList. 

• Save Page: This command enables you to save the active page. This enables you to 
create pages, reuse them, give them to others, etc. The page is saved in a single file, 
with the file extension “.ova”. 

• Close Page: This command closes the active page’s window. Note that closing the 
page’s window does not throw away changes you’ve made to the page.  

• Save This Page To Internet: This command enables you to save an individual page to 
the Internet. This saves time when you want to add or edit a single page or just a few 
pages on your web site. You go to the name of the pages you’ve added or edited and 
choose this command. It will then build the page and upload it to the web site. Note that 
the page you’re uploading doesn’t have to exist on your site on the net. In fact, the site 
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doesn’t have to exist. The command will create a new site for you if necessary. Press 
Upload to save to the net. 

Note: Saving individual pages to the net is not without “danger.”  It is possible for you 
to upload pages that have links to pages that haven’t been uploaded yet. In such a case, 
clicking such a link will cause an error in the browser.   

If you are using Frames, it is possible to upload part of the frame pages, but not others. 
In such a case, the pages that are not uploaded will not show up in the frames properly. 
To avoid confusion, it is best to upload your entire site first, and then use Save Page to 
Internet to save edited pages, and individual new pages to your site. 

• Trial Host this Page: This unique feature of Web Studio enables you to put the current 
page on the internet even if you don’t have an web site hosting account.  When you 
choose this command the iHostStudio Wizard will come up asking for your name and 
email address.  Enter these and your page will be immediately uploaded to the web. The 
Wizard will show you the web address, or URL, to your page at the top of the dialog.  
Record this for later use. Press the View Site Now button in the Wizard to see your page. 
Trial Hosting sites will remain on the net for 24 hours. 

Facts About Trial Hosting 

• Trial Hosting is FREE!  

• Use it to test changes you’ve made to your site before you replace your real site 
with your modified one. Trial Hosting gives you your own “Development 
Environment!”  

• You can upload your site to the internet even before you have an internet 
hosting account! You are instantly on the web with Web Studio! 

• Your site remains on the net for 24 hours. 

• Try your site on the net to see how it looks. 

• Get feedback from others about how your site looks and acts when on the web. 

• Trial Hosting only requires you to enter your name and email address and then 
uploads your site to a temporary site.  

• You can use Trial Hosting as much as you like, no limits!  

• It shows you how nice and easy iHostStudio hosting is. 

 

• View Source: This command brings up the View Source window which contains the 
HTML that makes up the current page. This is useful if you are adding your own HTML to 
your page or objects on your page. This is a quick way to see if it you have entered it 
correctly. Note that you cannot edit the HTML for the page in this dialog. 

• Snap To Grid: This turns on the Grid. The grid is a layout tool that helps you quickly 
and accurately layout pages, align objects, etc. When the Grid is turned on it will display 
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on the page’s background. Small grids will display as a grid of dots, medium sized grids 
as a grid of crosses, large grids as a grid. 

• Grid Settings: This brings up the Grid Settings dialog. This enables you to change the 
size of the grid both vertically and horizontally. 

• Show Page Guides: This toggles the display of the page guides. These guides are 
based on the Target Page Design Size in the WebSite Properties dialog in the Website 
menu. They display the edges of the page size you selected there. 

• Remove Background: Remove the current background from your current Web page.  
Background will return to default white. 

• Remove Page Sound:  Removes any background sound file from the current page. 

• Page Properties: Displays the page properties box. 

Web Site 

 

• Save Web Site to Internet: This command does two things.  First, it builds your Web site 
as HTML code.  Second, it launches the Upload dialog that will upload your files to the World 
Wide Web.  Press the Upload button in the Site Info dialog to save to the net. For detailed 
instructions on uploading your site, see chapter 25 "Saving Web Sites to the Internet".  

•  

 

• Trial Host Web Site: This unique feature of Web Studio enables you to put your web site 
on the internet even if you don’t have an web site hosting account.  When you choose this 
command the iHostStudio Wizard will come up asking for your name and email address.  
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Enter these and your site will be immediately uploaded to the web. The Wizard will show you 
the web address, or URL, to your site at the top of the dialog.  Record this for later use. 
Press the View Site Now button in the Wizard to see your site. Trial Hosting sites will remain 
on the net for 24 hours.  

• Facts About Trial Hosting 

• Trial Hosting is FREE!  

• Use it to test changes you’ve made to your site before you replace your real site 
with your modified one. Trial Hosting gives you your own “Development 
Environment!”  

• You can upload your site to the internet even before you have an internet 
hosting account! You are instantly on the web with Web Studio! 

• Your site remains on the net for 24 hours. 

• Try your site on the net to see how it looks. 

• Get feedback from others about how your site looks and acts when on the web. 

• Trial Hosting only requires you to enter your name and email address and then 
uploads your site to a temporary site.  

• You can use Trial Hosting as much as you like, no limits!  

• It shows you how nice and easy iHostStudio hosting is. 

• Save Web Site to Hard Drive: This command enables you to "post" your site on your hard 
drive or in a network folder.  This provides you with a convenient way to build, browse, and 
archive your site on your computer or a network that you are connected to. 

• Frame Properties: This command brings up the Frame Properties dialog. This dialog 
enables you to specify any of eight different frame combinations, the pages that will fill the 
frames and other properties of the frames. See chapter 20 Frames. 

• Web Site Properties: Displays the Site Properties box. See “WebSite Properties Dialog” in 
chapter 19, Web Studio’s Property Dialogs. 

Web Hosting 

 

iHostStudio Account Manager: Web Studio can use any hosting service that uses FTP (just 
about 99.999% of them do), however, it has its own iHostStudio web site hosting built in. 
Web Site Hosting Preferences enables you to open, modify, or close your iHostStudio hosting 
account and to choose to use another hosting company. 
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The advantages of iHostStudio hosting are: 

Hosting 

• Works seamlessly with Web Studio, first time, every time! 

• Four great hosting plans available from basic to full e-commerce; 

• No long term contract, it is month-to-month, no prepaid fees, you’re not locked 
in! 

• The iHostStudio Shopping Cart with all business plans; 

• Server Side functionality like counters, guest books, forms, secure pages, etc.; 

• Advanced features like ASP, PHP, MySQL, Access databases and more; 

• Gigabytes of space, bandwidth, email, and much more. 

Domain Name Registration 

• Register your own domain with iHostStudio, i.e. www.mysite.com 

• If you already have a domain name you can transfer it to iHostStudio to get the 
other benefits of iHostStudio’s uploading and hosting. 

Uploading 

• It is built into and designed specifically for Web Studio; 

• It doesn’t require you to know anything about uploading or FTP or servers, etc.; 

• It uploads at twice the speed of any other FTP program; 

• It will upload only the changes you’ve made to your web site or web page; 

 

Using iHostStudio Account Manager  

To choose your hosting preferences, choose WebHosting>iHostStudio Account Manager. 
This command brings up the iHostStudio Account Manager dialog.  

• To open a new account click on the Open  button. The iHostStudio Wizard 
will come up. Enter the required information to open your account. 

Note that you can purchase a domain name in the iHostStudio Wizard if you 
don’t already have one.  

Also, note that if you do have a domain name, you can transfer it to 
iHostStudio in the wizard. 

• Click the Modify button to change your account information, to change your 
hosting plan or other information. 

• Click the Close button to close or cancel your account with iHostStudio. Note 
that you’ll have to choose WebHosting->Use a different hosting service in 
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order to upload to another hosting service if you Close your iHostStudio 
account. 

• Use iHostStudio for this Site: Tells Web Studio to use iHostStudio for this website. If you 
haven’t opened your account, you’ll be prompted to do so when you choose WebSite>Save 
Web Site To Internet or Page>Save This Page To Internet. 

• Use Another Host for this site: Tells Web Studio you’d like to use a different hosting 
service. 

Note: With either of these options, you will only notice the differences you’ve chosen when 
you save your site to the internet by choosing WebSite>Save Web Site to Internet or 
Page>Save This Page to Internet. What you’ll notice is the iHostStudio Upload Wizard is 
different than the “Use different Hosting” wizard, also known as the Web Studio Publisher. 

Note: See Chapter 25, Saving Web Sites To The Internet for detailed information about 
using these commands. 

Preview 

 

• Preview This Page: This command builds the current page and previews it in the Web 
Studio browser.  

Note: none of the other pages of your site are built when you choose Preview This Page, so 
links to other pages in the site won’t work. They will work correctly when you Preview the 
entire site. 

• Preview Web Site: This command builds then previews your Web site in the Web Studio 
browser, giving you an exact replication of your site.  Here you can see how the site will 
work on the Web.  You can check for broken links, missing links, and any layout 
inconsistencies.   

• Back: This takes you back to the previously viewed Web page. 

• Forward: Advances you to the next Web page. 

• Stop: Stops the current Web page from loading into the browser. 
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• Refresh: Reloads the current page into the browser. 

• Back To Preview: Returns you to the first page of the previewed Web site from current 
Web page. 

• Go To: Opens the URL dialog on to the screen.  From here, you can type in any URL and 
visit another site. 

Note: The Preview window in Web Studio is an actual, full featured web browser. This means 
you can go to other websites on the net. This is important to when you want to test links you 
have to other websites, or when you want to just check out another site. You can use the Go To 
button to enter any URL and then go to that site. 

 

Window 

 

• Close All: Closes all of the open page windows.  

• Cascade: Choosing the Cascade command will arrange your windows in a cascading or 
descending fashion with the "active" Web page (the one you are working on) in front.  

• Tile: Choose Tile and any open Web pages you are working on will "tile".  This is a nice way 
to see all of your pages at the same time. 

• Page Number or Name: This will list any pages open in Web Studio.  Clicking on the name 
of one will activate that page.  The check mark will signify which window is currently open. 
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Help 

 

The Help menu offers a list of options to aid you in using Web Studio.  Here’s what’s in there. 

What’s New in Web Studio 4.0: Brings up an Adobe Acrobat file containing the highlights of 
the new features and enhancements in Web Studio 4.0 

Web Studio Documentation: Brings up an Adobe Acrobat file containing the entire Web 
Studio 4.0 User’s Manual. 

Tip of the Day: Brings up the Tip of the Day Dialog. 

Official Web Studio Web Site: Takes you to the WebStudio.com web site.  

The site is filled with resources for Web Studio. There are learning centers; content galleries; 
Web Studio articles written by expert Web Studio users and authors; Frequently Asked Questions 
or FAQ’s on many subjects; user’s gallery of web sites you can browse for ideas; the Web Studio 
Forum where people meet to get help, exchange ideas, and much, much more.  

It is also where you can purchase other Web Studio related products, learn about upcoming 
events and products, get your registration numbers and more. It is truly an extension of Web 
Studio itself! 

Web Studio On-Line Tutorials: Takes you to the WebStudio.com web site’s Tutorials page. 
Here you’ll find tutorials and videos that cover just about every aspect of Web Studio. You’ll know 
everything when you’re finished, well almost! 

Web Studio On-Line FAQ’s: Takes you to the FAQ Table of Contents page of the 
WebStudio.com web site.  
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This is the most used part of the WebStudio.com site. The FAQs cover just about every aspect of 
using Web Studio. There are tips, tricks, solutions to common problems, and much, much more. 

Web Studio On-Line Forum:  Takes you to the Web Studio moderated, on-line forum. Here 
you will find our moderators and other Web Studio users who can answer just about any 
question you have.  

Web Studio On-Line Articles: Takes you to a collection of feature length articles about using 
Web Studio.  

Web Studio On-Line Newsletters: Takes you to the Newsletter Archive where you can read 
any of the past monthly newsletters. Each issue contains a feature article, tips, trick, techniques, 
even information about how to market your website. 

Web Studio On-Line Resources: Takes you to the Resources page of the WebStudio.com web 
site. This is the gateway to many of the resources contained in the Help menu. 

Web Studio Customer Support: Takes you to the Support page of the WebStudio.com web 
site. This is the quick way to get info about customer support, tech support, downloads and 
patches, online manuals. 

iHostStudio Web Site Services: Takes you to the iHostStudio web site. You can learn all 
about the iHostStudio hosting plans, upgrade your hosting plan, administer your site, administer 
your email accounts, get your site’s statistics, do search engine submissions, register and transfer 
domain names, and much more. 

Web Studio Shopping Cart: Takes you to the iHostStudio Shopping Cart page. Here you can 
read about the different hosting plans, how the cart works, as well as try a demo of the shopping 
cart. 

Web Studio Version Info: This dialog contains version information which is important when 
you want to get technical support for your program. 

About Web Studio:  Brings up the Web Studio about box. It lists those who contributed to Web 
Studio, contains copyright notices for those partners whose software components and content 
are incorporated into Web Studio. 

Right Click Context Menus 
Right click context menus are used extensively throughout Web Studio.  Using Context Menus in 
the program will save you the time of having to go the Program Menus again and again for 
editing commands.  As you grow more familiar with Web Studio, you will want to use right-click 
context menus more often.   

Right click context menus are activated when you click your right mouse button over a specific 
object or text.  Object specific menus will pop up, allowing you to choose many of the same 
options available on the Program Menu toolbar. 
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Right Click Object Context Menu, Single Selected 
Object  

 

     This right click object menus display for all items except backgrounds and text. 

 

• Save Selected Object As: This enables you to save a selected graphic to disk or to save 
the contents of a selected text object to disk.  

• Undo: Undo your last action.  The menu text will specify what will be "undone".  This feature 
has no limit, so you can undo all of your actions right up to the point you opened the Web 
site.  In addition, each page you are working on maintains its own undo list.  So, switching 
between pages will not affect the undo list for other pages. 
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Note: As the Undo list grows, the amount of Computer Memory required to maintain it 
grows.  Each time you save your site, memory is freed up, and the Undo list is erased.  For 
this reason it is a good idea to save your site as you go.  So, Save when you are happy with 
your site and your system should perform a bit faster as a result. You can also choose Edit-
>Clear Undo Lists if you don’t want to save or if you want to free memory quickly. This is 
because Clear Undo Lists will clear the undo lists for all open pages at once. 

Note 2: Just in case you didn’t read the previous note, please read this one. 

There are a few things that will clear the undo lists: Using Save As or Save clears all page’s 
lists, closing a page clears that page’s list, closing the site clears all page’s lists, choosing 
Clear Undo Lists clears all page’s lists. 

• Redo: This will undo your undo.  The menu text will notify you what will be "redone". 

• Cut: Cut will place the image or text you have chosen to the Clipboard and remove it from 
the page you are working on.  This is not limited to one object.  By holding down the Shift 
key and selecting several items, you can cut and paste several items at once!   

• Copy: Copy will place a duplicate of the image or text that you are working on to the 
Windows Clipboard, allowing you to paste it into another Web page or another program. 

• Clear: Clear will delete the image or text from the page.   

• Center on Page: This will center the selected object on the page. The width of the page 
that is used is the current width based on the settings in the Web Site Properties dialog. 

• Grid Settings: This brings up the Grid Settings dialog. This dialog lets you set the size of 
the grid both vertically and horizontally. When you add, move or resize an object when the 
grid is active, it forces the object to position itself on the closest grid points. The object 
actually “snaps” to the grid. This is a great aid for quickly laying out pages and aligning 
objects. 

• Bring Selected Object to the Front: This moves the selected item to the top layer of your 
Web page.   

• Send Selected Object to the Back: This moves the selected item to the bottom layer or 
your Web page.  If you choose this command and wish to undo its effect, simply right-click 
and choose Undo Send to Back. 

• Move Selected Object Forward: Moves the selected object one layer forward. 

• Move Selected Object Backward: Moves the selected object one layer backward. 

• Transparent: Changes the transparency of an object.  When transparent, it appears to be 
floating above the background.   

• Transparent Color 

• Transparent White: Default.  Any white in the object is transparent. 

• Choose Color: Enables you to change the transparent color. 
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• Take Object Apart: Takes multi-part graphic objects apart and places each graphic on the 
page in sequence. Multi-part graphics are Animations and Rollover buttons. This is useful for 
changing the order of an animation, adding to an animation or deleting graphics from an 
animation. It can be used with Rollover Buttons to change the order or change one or more 
of the graphics in an existing Rollover. 

• Resample Graphic: When you resize a graphic its quality goes down. Choosing Resample 
will tell Web Studio to make the resized graphic look better. 

• Set Compression: Enables you to specify the amount of compression to apply to this 
graphic when it is on the web. There are 9 quality levels of compression available. Level Q1 
applies no compression at all. Level Q9 is maximum compression and visibly degrades the 
image. The default compression quality level is Q2, which provides compression with virtually 
no loss of visual quality. 

• Turn into a Protected Graphic: This turns the selected graphic into a Protected Graphic. 
The Windows Save As dialog will come up to enable you to save the graphic to disk. 
Protected Graphics can be used many times on a site while being uploaded only once. In 
addition, a Protected Graphic is not changed in any way by Web Studio when it uploads the 
graphic. 

• Add/Edit Link: This brings up the Add/Edit Link dialog. This enables you to add a new link 
to the selected object or to edit the link already attached to the object. 

• Remove Link: Removes the Hyperlink from the selected object. 

• Properties: Displays the object properties box. 
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Right Click Object Context Menu, Multiple Objects 
Selected  

 

 
This menu shares many commands with the previous menus. Only those commands unique to 
this menu will be described here. See the previous sections for descriptions of the others. This 
menu is brought up by right clicking on an object when multiple objects are selected. 

• Center Selected Objects: Centers two or more objects relative to each other. It centers 
relative to the first object selected. 

• Space Evenly Across: Spaces out the selected objects evenly from left to right. 
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• Space Evenly Down: Spaces out the selected objects evenly up and down. 

• Make Equal… 

 

• Make Equal Size: Makes the selected objects the same size. To select two or more objects 
hold down Shift and select each object with the Mouse.  Resizes to the first object selected. 

• Make Equal Width: Makes the selected objects the same width. To select two or more 
objects hold down Shift and select each object with the Mouse.  Resizes to the first object 
selected. 

• Make Equal Height: Makes the selected objects the same height. To select two or more 
objects hold down Shift and select each object with the Mouse.  Resizes to the first object 
selected. 

• Merge Selected Objects: Merges selected graphics into one graphic.  Similar to merging 
layers in graphics programs.  

• Resample Graphic: When you resize a graphic its quality goes down. Choosing Resample 
will tell Web Studio to make the resized graphic look better. Using this command enables you 
to select multiple objects to be resampled all at once. 

• Remove Links: Removes the Hyperlinks from the selected objects. 
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Right Click Text Menu  

 

This menu shares many commands with the previous menus. Only those commands unique to 
this menu will be described here. See the previous sections for descriptions of the others. The 
right click text menu appears when you right click over any text object. 

 

• Font: Enables you to alter the selected Text on the page.  Displays the standard Windows 
Font dialog box. 

• Text Background Color 

• Transparent Text Background: Default option.  Makes the Text appear on the 
background. 

• Text Background Color: Enables for a colored box to be placed behind the text. 

• Text Color: Changes the color of the highlighted text. 
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• Edit HTML Source (Advanced feature): This enables you to edit the source in the selected 
text object. You may want to do this to add some advanced HTML features to your text 
object. 

• Search and Replace: This enables you to search for any text in a text object and optionally 
replace it with other text. 

• Properties: Displays the object properties box.  The Text Object Properties dialog shares 
many tabs with other objects. 

Right Click Background Menu  

 

The right click background menu appears when you right click over a page background. Many of 
the commands on the Background menu are shared with other menus. Only those specific to the 
Background menu will be described here. For descriptions of the other menu commands see the 
previous menu descriptions. 

 

• Copy Background: Copy Background will place a copy of the page’s background graphic on 
the clipboard. It will not place a copy of a page’s background if it is a simple solid color 
background. The purpose of Copy Background is to enable copying backgrounds from one 
page and using Paste As Background to past it into other pages. 

• Paste in Place: This will Paste an object in the same location on the page that it was Cut or 
Copied from. This is handy when you want to place objects in the same location on different 
pages. Place them where you want on one page, copy them, go to other pages and choose 
Paste In Place. 



Web Studio 4.0  Chapter 28: Expanding Web Studio 

 

• Paste as Background: Enables you to paste the selected image as your background. 

• Select All: Select All selects every item on your Web page including text, graphics, and 
photos.  This enables for a group move or a group cut or copy. When you are editing text, 
select all will select all of the text in the object you are editing. 

• Preview This Page: This command builds the current page and previews it in the Web 
Studio browser.  

Note: none of the other pages of your site are built when you choose Preview This Page, so 
links to other pages in the site won’t work. They will work correctly when you build the entire 
site. 

• View Page Source: This brings up a dialog with the HTML source code for the current page 
displayed. This is useful to determine if HTML or other code that you have added was done 
correctly. It is also educational to look at the HTML source and see how it relates to what is 
on your page. The source is “read only”, which means it cannot be edited. 

• Grid Settings: This brings up the Grid Settings dialog. This enables you to change the size 
of the grid both vertically and horizontally. 

• Remove Background: Removes current background.  Reverts to default white background. 

• Remove Page Sound:  Removes any background sound file from the current page. 

• Page Properties: Displays the page properties box. 

 

 


